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The Edit page is also home to many of the compositing and effects features found in DaVinci 
Resolve. Many effects can be imported into DaVinci Resolve, including composite modes, opacity 
settings, linear and nonlinear speed changes, and clips using alpha channels. Once in Resolve, you 
can make changes to these effects in the Edit page. Alternately, you can also use Resolve’s controls 
to create effects from scratch.
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Using the Inspector

The Edit page Inspector, which is closed by default, is the central area for editing effects parameters 
relating to compositing, sizing, titling, transitions, generators, and effects of all kinds. Many of 
the instructions in this chapter require the use of the Inspector, which can be opened or closed 
by clicking the Inspector button at the far right of the Edit page toolbar, or by double-clicking a 
transition or generator in the Timeline.

The Inspector, with the button that opens and closes it shown bottom right, displays different parameters depending on what you’ve 

selected in the Timeline; (left) parameters of a clip, (right) parameters of a title

The parameters displayed in the Inspector are those of the currently selected item in the Timeline. 
Changing the selection changes which parameters are displayed, and the parameters you edit 
in the Inspector only alter the currently selected clip. If multiple clips are selected, the Inspector 
displays and edits only the leftmost clip within the selection.

Most parameters in the Inspector are organized into groups, with a title bar providing the name 
of that group, along with other controls that let you control all parameters within that group at the 
same time.
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These controls include:

>> Enable button: A round orange button to the left of the parameter group’s name lets you 
disable and re-enable every parameter within that group at once.

>> Close button: This button only appears when you move the pointer over the title bar, 
revealing itself as the word “Close.” Clicking this button collapses the group so that only 
the title bar is displayed, freeing up room in the Inspector for other parameters. Option-
clicking the hide button collapses or opens all parameter groups at once.

>> Keyframe button: This button lets you add or remove keyframes at the position of the 
playhead to or from every single parameter within the group.

>> Reset button: Lets you reset all parameters within that group to their default settings.

Closed and open Inspector group controls
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There’s a collection of titles and generators in the Toolbox that you can use to create leader when 
outputting to tape, add slates, create subtitles, and otherwise fulfill any textual needs your  
program has.

The available titles in the toolbox

Titles and generators can be edited much like any other clip. Furthermore, when selected, both titles 
and generators expose the same Composite, Transform, and Cropping parameter groups as any 
other clip; these parameters can be used to composite titles and fly them around in order to create 
different text effects.

Methods of adding and editing generators and titles:

>> To drag and drop a generator directly into the Timeline: If you simply drag and drop titles 
or generators into the Timeline, the default duration of the resulting clip is 20 seconds. This 
duration can be customized in the Edit panel of the Project Settings.

>> To edit a generator using the edit overlays of the Timeline Viewer: Click the destination 
control of the clip you want to edit a generator into, then set Timeline In and Out points to 
define the duration of the resulting edit, and drag the generator you want to edit onto the 
edit overlay of the Timeline Viewer that corresponds to the type of edit you want to perform.

>> To edit the parameters of a generator or title: Open the Inspector, and select the generator 
or title you want to edit to open it into the Inspector.

Using Safe Area Overlays

If you’re working on a broadcast program and you want to adhere to guidelines for title safe and 
broadcast safe, you can choose to display overlays that indicate where these regions are in the Edit 
page. To do so, choose View > Safe Area > Master On/Off. 

Adding Titles
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The available safe area overlays

If necessary, there are a number of ways you can customize this overlay by choosing one of the other 
options in the View > Safe Area submenu to toggle specific parts of the Safe Area overlay on and 
off. These options include:

>> Extents: An outline showing the exact outer edge of the frame. Especially useful when the 
safe markers are set to an aspect ratio other than that currently used by the Viewer.

>> Action: An outline showing the outer 90% action safe area of the frame.

>> Title: An outline showing the outer 80% title safe area of the frame.

>> Center: A crosshairs showing the center of the frame.

>> Aspect: Enables use of the View > Select Aspect Ratio submenu to change the aspect ratio 
of the safe area markers. You can choose among the following aspect ratios: 1.33 (a.k.a. 4:3), 
1.66, 1.77 (a.k.a. 16:9), 1.85, and 2.35.

Types of Title Generators

When opened into the Inspector, titles expose a set of text parameters that allow you to style the 
contents of that clip’s Text field within the Inspector. Each of the titles supports rich text, so you 
can individually style words, lines, or paragraphs of text using the available parameters including 
Color, Font, and Size. Other attributes such as Alignment, Anchor, Position, and Shadow affect the 
entire title.

The following titles are available:

>> Simple: Useful for creating titles consisting of one word, line, or paragraph of text. A single 
body of text shares one set of rich text controls.
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>> Scroll: Automatically automates a scrolling title sequence from the bottom to the top of 
the screen. The duration of the generator clip in the Timeline determines the speed of the 
scroll. Identical parameters as the Simple title.

>> L Lower 3rd: Automatically positions two lines of text at the bottom left corner of title safe, 
each with a different set of rich text controls.

>>M Lower 3rd: Automatically positions two lines of text at the bottom middle of title safe, 
each with a different set of rich text controls.

>> R Lower 3rd: Automatically positions two lines of text at the bottom right corner of title safe, 
each with a different set of rich text controls.

Shared Title Generator Parameters

The title generators in Resolve are all capable of rich text styling, meaning that you can select any 
portion of a generator’s text and style it differently. For example, you could have three lines of text 
within a single generator, and style each line individually to create a particular design.

Each title generator shares the same parameters:

>> Rich Text: A control group consisting of a text entry field and parameters that can be used 
to style different parts of the text independently.

>> Text: A text entry field for editing the title being generated. If no characters are 
selected, the styling controls affect the entire block of text. If you select a specific set 
of characters, the styling controls only affect the selection.

>> Font family: A pop-up for choosing one of the font families installed on your workstation.

>> Font face: A pop-up for choosing which face of the font family currently selected to use.

A single generator with three lines of differently styled text
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>> Color: Opens the standard color picker for choosing a font color.

>> Size: Slider for choosing the text size.

>> Tracking: Slider that sets the spacing between characters.

>> Line spacing: Slider for setting the spacing between the selected line of text and the 
next one below.

>> Font style: Buttons to apply underline, overhead line, strikethrough, superscript, and 
subscript styling.

>> Font case: A pop-up for forcing the text selection to be Mixed Case (the default), All 
Caps, All Lowercase, Small Caps, or Title Caps.

>> Alignment: Buttons to select the method of alignment: left, centered, right, or justified.

>> Anchor: Buttons for selecting how text is anchored to the current position, both 
horizontally (top, centered, bottom) and vertically (right, centered, left).

>> Position: X and Y parameters determining the bottom left-hand corner (the default 
Anchor settings) of the rich text block being generated.

>> Drop shadow: Let you apply a customizable drop shadow to every character of text 
being generated.

>> Color: Opens the standard color picker for choosing a drop shadow color.

>>Offset: X and Y parameters determining how offset the drop shadow is from the 
original text.

>> Blur: A slider for blurring the drop shadow.

>>Opacity: A slider determining how transparent the drop shadow is.

>> Stroke: Lets you add an outline to every character of text being generated.

>> Color: Opens the standard color picker for choosing the stroke color.

>> Size: A slider lets you choose the thickness of the stroke, in pixels.

>> Background: The background controls provide an extremely flexible rectangle or 
rounded rectangle shape that you can use to add a background, bar, outline, or other 
intersecting shape to use when designing a title.

>> Color: Opens the standard color picker for choosing the interior color of the 
background shape.

>>Outline color: Opens the standard color picker for choosing outline color of the 
background shape.

>>Outline width: A slider lets you choose the thickness of the background shape outline, 
in pixels.
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>>Width: A slider lets you choose how wide to make the background shape.

>> Height: A slider lets you choose how tall to make the background shape.

>> Corner radius: A slider lets you choose the roundness of the rectangle edges.

>> Center: X and Y parameters you can use to offset the background shape from the text 
being generated.

>>Opacity: A slider lets you set the transparency of the background shape.
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Using Generators

Generators, with the exception of Solid Color, lack editable parameters with the exception of the 
Composite, Transform, and Cropping parameters that are standard for every clip.

The following generators are available:

>>Gray Scale: A simple grayscale ramp from black to white.

>> EBU Color Bar: A 1.77:1 aspect ratio set of color bars for PAL-using countries.

>> SMPTE Color Bar: An updated 1.77:1 aspect ratio set of color bars for NTSC-using countries.

>> 10 Step: A grayscale ramp segmented into 10 steps from black to white.

>> 100mV Steps: A grayscale ramp segmented into segments of exactly 100mV each.

>>Window: A simple white on black shape generator, defaulting to a white rectangle against 
a black background.

>> YCbCr Ramp: A gradient designed to test the Y’CbCr signal.

>> Solid Color: A simple fullscreen color generator. A Color parameter lets you choose what 
color this generator outputs.
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Using Stills

You can import still images into the Media Pool, and edit them into the Timeline as clips with 
custom durations. By default, imported stills are 10 seconds long, but you can extend a still image’s 
Out point to a maximum of 17 hours and 40 minutes in length, which ought to cover just about 
any project you’re planning on working on, so long as you’re not Andy Warhol. DaVinci Resolve is 
correspondingly capable of importing still image clips referenced by XML or AAF project files, so 
long as they’re in a supported format. 

DaVinci Resolve supports the use of stills in the following formats:

Once edited into the timeline, still image clips have the same Composite, Transform, Cropping, 
Retime and Scaling attributes as any other clip.

Photoshop File Support

Only the bitmapped layers of Photoshop (.psd) files appear within DaVinci Resolve as a single clip in 
the Timeline. Photoshop text layers and layer effects are not supported.

File Format Alpha 

.tif Yes

.png Yes

.jpg No

.dpx No

.exr Yes

.dng No

.psd No
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Composite modes are effects that use various mathematical operations to combine one superimposed 
clip with another, relying on standard image processing math for each color channel whereby black 
pixels have a value of 0, white pixels have a value of 1, and descending levels of gray are represented 
by decimal point values (for instance, 0.5 represents 50% gray). When using composite modes to 
blend two clips together on the Timeline, the three color channels of each pair of pixels are combined 
using that particular composite mode’s math. The results can create transparency effects, increase 
image exposure, and combine multiple images in many creative and useful ways.

When using composite modes, it’s easy to push parts of the resulting image above the maximum or 
below the minimum values for brightness. However, this image data is not clipped, even through such 
areas of the picture may appear flat white or black. Out-of-range data as a result of a composite mode 
effect is preserved, and may be retrieved by later image processing operations in the Color page.

When you import XML project files, Resolve imports whatever composite modes were used by clips 
in the original sequence. If necessary, you can then change a clip’s composite mode to one that will 
work better with whatever grade you’re creating. Of course, you can also add composite modes to 
clips that didn’t originally have them, adding new effects of your own. 

All composite modes interact with the Opacity slider (found below the Composite Mode pop-up 
menu in the Inspector) to make a clip more or less transparent in addition to compositing already 
being done.

Composite Modes and Transparency Effects

Two source clips combined with the Hardlight composite mode
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Composite modes can be used on clips that are superimposed over other clips in the Timeline. 
However, these composite modes are also available for use within a grade on the Color page using 
the Layer Mixer node, within which you can combine differently graded versions of an image in 
creative ways. For example, the Add and Overlay composite modes can be useful for creating glow 
effects, while Subtract and Difference can create more surreal effects.

Working with composite modes in the Edit page is simple.

To set or change a composite mode for any clip:

>> Select a clip in the Timeline, then open the Inspector and choose one of the options from 
the Composite Mode pop-up menu.

To turn a clip’s composite mode off:

>> Select a clip in the Timeline, then open the Inspector and choose Normal from the 
Composite Mode pop-up menu.

More About Composite Modes

There are ten composite modes to choose from. For clarity, simple image math is used to help 
explain the available Composite Mode effects.

Normal

No image compositing is done. The topmost image on the Timeline or the bottom input of the 
Layer Mixer node occupies the entire frame.

Add

Each pair of pixels in both superimposed layers is added together. Layer order does not matter. This 
can result in a dramatic brightening of light areas of both images with areas of the picture that are 
blown out to maximum white, and this effect is often used by adding the brighter part of an image 
to itself to create hot glow effects. Image data going above 1.0 is preserved and may be retrieved 
by later color correction operations. On the other hand, black areas of either image do not alter the 
combined image at all (0 + n = n).

Composite mode and opacity controls in the Timeline
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Subtract

Within each pair of pixels, those of the bottom layer are subtracted from those of the top. This can 
result in dark areas of the image that hit flat black, but image data going below 0 is preserved and 
may be retrieved by later color correction operations.

Difference

The absolute value is taken of the top layer minus the bottom layer, and returned as the result, which 
is always a positive number. Layer order does not matter. This Blend mode is often used to compare 
two differently-processed versions of the same image to see if there are any alterations, and how 
large they are.

Multiply

Each pair of pixels is multiplied together. Layer order does not matter. This generally has the effect 
of emphasizing the darkest parts of both images in the resulting output; in particular black areas of 
either image are preserved (0 * n = 0) while white areas of either image have no effect on the output 
image (1 * n = n). Multiply is good for compositing darker elements in a field of white into an image, 
and can be used to emphasize the darkest parts of a noise, grain, or damage layer you’re blending 
with an image.

Screen

The pixel values of each layer are inverted, then multiplied, and the result is itself inverted. Layer 
order does not matter. Screen is the inverse of Multiply, as it preserves the lightest parts of both 
images, and is useful when compositing lighter elements in a field of black into an image, and 
can be used to emphasize the lightest parts of a noise, grain, or damage layer you’re blending 
with an image.

Overlay

Overlay combines useful aspects of both the Screen and Multiply composite modes, based on 
the pixel values of the bottom-most image on the Timeline; all bottom layer pixels above 50% 
are Screened, while all bottom layer pixels 50% and below are Multiplied. Overlay is an excellent 
composite mode for combining a layer of noise, grain, or damage imagery with another clip,  
as it combines both images in visually useful ways throughout the tonal range of shadows 
through highlights.

Hardlight

Hardlight is the opposite of Overlay. All bottom layer pixels above 50% are Multiplied, while all 
bottom layer pixels 50% and below are Screened.
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Softlight

A less intense method of applying the Hardlight composite mode that results in a more even blend 
between the two layers.

Darken

Each pair of pixels is compared, and the darker of the two is the output. Layer order does not 
matter. Darken is useful when you want the darker features of both layers to take precedence.

Lighten

Each pair of pixels is compared, and the lighter of the two is the output. Layer order does not 
matter. Lighten is useful when you want the lightest features of both layers to take precedence.

Unknown

When importing XML or AAF project files with composite modes that aren’t available in Resolve, 
the Composite Mode pop-up menu is set to Unknown; practically, this is the same as Normal.

Opacity

Each clip has an Opacity parameter, available in the Inspector, that lets you make it more transparent, in 
a range from 0 (totally transparent) to 100 (totally opaque). When set to a value less then 100, the selected 
clip is mixed with whatever clip is underneath it on the Timeline, according to the composite mode 
that’s currently used. If no clip appears underneath the Timeline, then the clip is mixed with black.

By keyframing this parameter, you can create more complicated fade to black effects or cross-
dissolves. Keyframing is covered in more detail later in this chapter.

To change a clip’s opacity:

>>Open the Inspector, then select the clip you want to adjust, and set the Opacity slider to 
create the desired amount of transparency.

Video Fader Handles

If you want to dissolve a clip to or from another clip, or to or from black, the traditional way to do 
so has been to use one of the transitions in the Effects Library. However, you can now use Fader 
Handles that appear at the beginning and end a clip when you position the pointer right over it. 
Fader handles are a fast, ubiquitous method of creating a fade to or from black. However, they also 
make it easy to fade to or from other clips that are underneath one that’s superimposed, as seen in 
the following screenshot.
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To use a fader handle, move the pointer over the clip you want to adjust, and when small green 
fader handles appear at the upper left and upper right of the video of the clip, drag them to the left 
or right for the duration you want the fade effect to last.

Alpha Channel Support

If a superimposed video or still image clip in the Timeline has an embedded alpha channel, that 
alpha channel automatically creates transparency within that clip, compositing it against whatever 
is in the track underneath. There’s no need for you to do anything for this to work. 

However, if you want to disable the alpha channel for any clip, for example if a clip is being interpreted 
as having an alpha channel incorrectly, you can use the Find in Media Pool command to select that 
clip in the Media Pool, where you can right-click it and choose Change Alpha Mode > None.

However, if you want to disable the alpha channel for any clip, for example if a clip is being interpreted 
as having an alpha channel incorrectly, you can use the Find in Media Pool command to select that 
clip in the Media Pool, where you can right-click it and choose Alpha > None.

Superimposing a clip with an alpha channel above automatically composites that clip against the clip beneath it

Dragging a video fader handle on a clip in track V2
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Keying, External Mattes, and Window Compositing

It’s also possible to use the Qualifier, Power Window controls, and External Matte clips in the Color 
page to create compositing effects by connecting a key that you create to the optional Alpha 
Output that can be added to the Node Editor. In this way, you can pull a simple greenscreen key 
using a qualifier, do rotoscoping or matte work using a Power Window, or use an External Matte to 
composite two or more clips together, and see these effects on the Edit page.

For more information on use of the Alpha Output to do node-based compositing, see Chapter 12, 
“Advanced Color Features.”
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DaVinci Resolve is a resolution-independent application. This means that, whatever the resolution 
of your source media, it can be output at whatever other resolution you like. This also means that 
you can freely mix clips of any resolution, fitting 4K, HD, and SD clips into the same timeline, and 
scaling each to fit the project resolution as necessary.

Your project’s resolution can be changed at any time, allowing you to work at one resolution, and 
then output at another resolution. This also makes it easy to output multiple versions of a program at 
different resolutions, for example, outputting both HD and SD sized versions of the same program.

DaVinci Resolve has a powerful tool set for making geometric transforms, using advanced 
algorithms for optical-quality sizing operations. Within the Edit page, each clip has a set of transform 
parameters, principally for use in storing sizing data imported from AAF or XML when you turn on 
the “Use sizing information” checkbox. This has the advantage of keeping these imported settings 
separate from the Input Sizing parameters found on the Color page, which are typically used by the 
colorist to make Pan and Scan adjustments of various kinds.

Of course, you can also use these controls to create your own adjustments while working in the 
Timeline, zooming into clips, repositioning them to improve the composition, etcetera. While there 
is some overlap between these parameters and those in the sizing palette of the Color page, they’re 
both separate sets of parameters, so you can keep each set of adjustments separate. 

When the time comes to output your program, the final resolution of each clip is calculated taking into 
account the original resolution of the source media, the timeline resolution, image scaling settings, 
Edit page transforms, and Color page transforms, so that the final resolution correctly uses the 
cleanest geometric transformation based on the maximum resolution available to each source clip.

The Edit page transform group includes the following parameters, which are also editable in the 
Edit Sizing mode of the Sizing palette in the Color page:

>> Pan and Tilt: Moves the image within the frame, allowing pan and scan adjustments to be 
made. Pan moves the image in the X dimension, and Tilt moves the image in the Y dimension.

>> Zoom X and Y: Allows you to blow the image up or shrink it down. The X and Y parameters 
can be linked to lock the aspect ratio of the image, or released to stretch or squeeze the 
image in one direction only.

>> Rotation Angle: Rotates the image around the anchor point.

>> Anchor Point X and Y: Defines the coordinate on that clip about which all transforms 
are centered. 

The Edit page has an additional set of cropping parameters:

>> Crop Left, Right, Top, and Bottom: Lets you cut off, in pixels, the four sides of the image. 
Cropping a clip creates transparency, so that whatever is underneath shows through.

Transform and Cropping
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The Retime and Scaling group also has a single parameters that affects clip scale:

>> Scaling: Lets you choose how clips that don’t match the current project resolution are 
handled. The default setting is Project Settings, so that all mismatched clips use the 
same method of being automatically resized. However, you can also choose an individual 
method of automatic scaling for any clip. The options are Crop, Fit, Fill, and Stretch, which 
are explained in more detail in the 2D Transforms section of Chapter 8, “Color.”

You also have the option of transforming or cropping clips using the Transform/Crop button at the 
bottom left of the Timeline Viewer.

Transform controls in the Timeline Viewer
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To transform a clip using graphical controls in the Timeline Viewer:

1.	 Click the Transform/Crop button at the bottom left of the Timeline Viewer to turn it on; orange 
is enabled, gray is disabled. 

2.	 Choose either the Transform or Cropping mode from the pop-up menu if necessary to 
change modes. The appropriate on-screen controls appear to let you manipulate the clip 
with the mouse.

Onscreen controls for transforming and cropping in the Timeline Viewer

>>When in Transform mode, you can drag anywhere within the clip’s bounding box to adjust 
pan and tilt, drag any diagonal corner to proportionally resize, drag any side to squeeze or 
stretch just width or height, or drag the center handle to rotate.

>>When in Crop mode, each side has a handle for cropping.

3.	 If necessary, choose a smaller viewing percentage from the Timeline Viewer scale pop-up to 
better see the on-screen controls if you’re rescaling the image.

4.	 When you’re finished, turn the Transform/Crop button off.



DAVINCI RESOLVE COLORIST REFERENCE MANUAL

338

EDIT PAGE EFFECTS7

DaVinci Resolve is capable of reading linear speed effects from imported EDL, AAF, and XML 
projects, and nonlinear speed effects from XML and AAF project files. When speed effects are 
present, Resolve plays clips at the specified speed. You can also create speed effects of your own 
using controls in the Edit page. There are three methods of adjusting clip speed; using the Inspector, 
using the Change Speed dialog, and using the Retiming effect in the Timeline.

Creating Simple Speed Effects

If all you need to do is to make a clip play in slow motion, speed it up, reverse the clip, or create a freeze 
frame, you can apply a simple speed effect using either the browser or the Change Speed dialog.

To change a clip’s speed, do one of the following:

>> Select a clip in the Timeline, open the Inspector, and scroll down to the Speed Change settings.

>> Right-click a clip in the Timeline, choose Change Speed, and use the controls of the Edit 
Speed Change dialog.

Speed Change operations have the following options:

>> Change Speed To parameter: Changes the speed of the selected clip by whatever 
percentage you like.

>> Ripple Sequence checkbox: If you want the speed change you’re about to make to ripple 
the Timeline, pushing or pulling all clips following the current one to accommodate the 
clip’s new size, then turn on the checkbox.

Speed effect parameters shown in the Speed dialog

>> Freeze Current Frame checkbox: Changes the entire clip to a freeze frame of whichever 
frame is at the current position of the playhead.

>> Reverse Clip button: Clicking this button sets the current speed to a negative value, 
reversing the motion of the clip.

Speed Effects



DAVINCI RESOLVE COLORIST REFERENCE MANUAL

339

EDIT PAGE EFFECTS7

Clip Retiming Controls

Another method of altering clip speed in the Timeline is to apply the Retime effect. This method of 
clip retiming provides a convenient control overlay that you can use to adjust clip speed directly in 
the Timeline, and it also provides the controls that are needed for creating variable-speed effects.

To apply the Retime effect to a clip:

>> Select a clip, and choose Edit > Retime Clip (Command-R).

>> Right-click a clip and choose Retime Clip from the contextual menu.

The Retime controls appear over that clip in the Timeline. They consist of a Retime control track 
running along the top of the clip with arrows that indicate the speed and direction of playback (the 
default blue right-facing arrows indicate normal 100% playback) and a Clip Speed pop-up menu at 
the bottom center of the clip, which also shows the current speed of the clip.

The Speed Effect controls in the Timeline

Retiming An Entire Clip

The simplest way of using the Retiming effect is to change the playback speed of the entire clip, 
in the process rippling the rest of the Timeline to the right of the retimed clip as you increase its 
duration by stretching or compressing its duration.

To retime a clip by dragging:

>>Move the pointer to the left or right edge of the Speed Change name bar on top of the 
clip, and when it turns into a Retime cursor, drag either side to stretch or squeeze the clip 
to retime it.

To retime a clip by specific amounts:

1.	 Select a clip and press Command-R.

2.	 Click the pop-up next to the speed percentage text at the bottom of the clip.
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3.	 Do one of the following:

>> Choose a new playback speed from the Change Speed submenu.

>> Choose reverse segment to make the clip play in reverse. Reverse speed is shown in the 
Retime control track as arrows facing left, instead of right.

To return a clip to its original speed:

>> Click the pop-up next to the speed percentage text at the bottom of the clip, and choose 
Reset to 100%.

Reading Clip Speed Arrows

When you retime a clip, the Clip Speed pop-up menu displays the current speed of the entire 
clip. Additionally, the arrows in the Retime control track show you the speed and direction of 
playback. When clip speed is slowed down below 100%, the Retime control track shows yellow 
playback triangles that are spaced farther apart. When clip speed is sped up above 100%, the 
Retime control track shows yellow triangles that are bunched closer together. At 100% normal 
speed, the Retime control track shows blue, evenly spaced triangles, while left-facing yellow 
arrows indicates reverse playback.

Three clips set to different speeds. From left to right, fast forward, slow motion,  

and reverse speeds are indicated by the yellow arrows.

Creating Variable Speed Effects

You can also use the Retime controls to insert freeze frames within the middle of a clip, and create 
other custom variable speed effects using speed points. Additional variable speed options include 
rewind and speed ramp effects, which automatically place speed points to create preset effects.

To create a freeze frame at a particular moment in time:

1.	 With the Retime controls exposed, move the playhead to the frame you want to freeze, within 
that clip. Ideally, this will be for an effect where you want a character in motion to suddenly 
stop at a particular frame.
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2.	 Open the Clip Speed pop-up menu, and choose Freeze Frame. Two new speed points are 
added to the clip, defining a range within which the clip is frozen at that frame. This can be 
seen by the vertical red bars in the retime control track. Past the second speed point, the clip 
resumes playback from the next frame forward.

Speed effect controls set to insert a momentary freeze frame within the clip

3.	 Drag the second speed point forward or back to define the duration of the freeze frame. The 
result is that the clip plays normally up until the first speed point, then freezes on that frame 
until the second speed point, at which playback resumes.

To create variable-speed effects:

1.	 With the Retime controls exposed, move the playhead to the frame at which you want to change 
the speed of the clip, and choose Add Speed Point from the Clip Speed pop-up menu.

2.	 Move the playhead forward to the next frame at which you want the clip speed to change 
again, and add another speed point. It takes a minimum of two speed points to create a 
speed effect.

3.	 To alter the speed of the clip segment appearing between these two speed points, do one of 
the following:

>> Using the pointer, drag the second speed point to the right to slow down clip playback, or 
to the left to speed up clip playback within just that segment.

>> Using the Clip Speed pop-up menu, choose a new speed for that segment from the 
Change Speed pop-up menu. You can also set any segment to play in reverse by choosing 
Reverse Segment.

4.	 To clear a speed point and eliminate that particular clip’s speed segment from the effect, 
choose Clear Speed Point from any Clip Speed pop-up menu to eliminate whichever speed 
point appears to its left.
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When you create variable-speed effects, the arrows in the Retime control track can help you 
keep track of what you’re doing, and each segment’s speed pop-up shows you the actual 
numeric speed. The change in speed from each speed segment to the next is automatically 
eased, for a smooth transition from one speed to another.

Speed controls set to ramp among three different playback speeds; arrow spacing shows the timing

There are two additional sets of commands for creating preset speed effects that use multiple 
speed points.

To add a rewind effect:

>>With a clip’s retime controls exposed, open any Clip Speed pop-up menu and choose a 
preset percentage from the Rewind submenu. This results in two additional speed points 
being added after the rightmost speed point in the current segment, which creates the 
effect of the current segment playing in fast reverse for the chosen percentage, and then 
playing a second time from the beginning.

Speed effect controls before and after creating a “rewind” effect
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To add a speed ramp:

>>With a clip’s retime controls exposed, open any Clip Speed pop-up menu and choose one 
of the two options from the Speed Ramp submenu to replace the current speed effect with 
a series of five speed segments that start at 10% and increase progressively to 30%, 50%, 
70%, and then 90%. Once created, you can drag the speed points to customize this effect 
to create whatever durations you require.

Speed effect controls set to create a gradual ramp from 0 to 100 percent playback speed

Closing Retime Controls

When you’re finished creating your Retime effect, you can close the Retime controls so that clip 
assumes a normal appearance again. Closing the Retime controls has no effect on the timing of the 
clip, it just ensures you cannot accidentally modify the speed of the clip with the mouse.

To close the Retiming controls in the Timeline:

>> Click the X button at the upper left-hand corner of the Retime control box.

>> Select the retimed clip, and either choose Edit > Retime Clip, or press Command-R.

When a retimed clip has its Retiming controls hidden, a Retime badge appears to the left of that 
clip’s name in the Timeline. You can reopen the Retiming controls whenever you need to make 
further changes.

The speed effect badge that shows a clip is being retimed
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To reopen the Retiming controls in the Timeline:

>> Select the retimed clip, and either choose Edit > Retime Clip, or press Command-R.

Once you’ve retimed a clip using the Retime effect, you can use that clip’s Retime Process parameter 
in the Inspector to define how that clip’s retiming is processed, using the low quality Nearest option, 
using Frame Blending, or using Optical Flow. 

Speed Effect Processing

Once you’ve retimed a clip, you have the additional ability to change how the retimed clip is 
processed in order to improve its visual playback quality, especially in the case of clips that are 
slowed down. There are two ways you can set this. First, there’s a project-wide setting available in 
the Master Project Settings. Secondly, you can change how clips are retimed via a per-clip setting 
available in the Inspector.

To change the Retime Process setting of an entire project:

1. 	 Open the Project Settings in the Master Project Settings panel.

2. 	 Scroll down to the bottom, and choose an option from the Retime Process pop-up menu.

To change an individual clip’s Retime Process setting:

>> Select a clip, then open the Inspector and choose an option from the Retime Process pop-
up in the Retime and Scaling group.
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Most parameters in the Inspector of the Edit page can be keyframed, in order to create animated 
effects such as zooming in via the Zoom parameter, fading out via the Opacity parameter, or 
cropping from one side to reveal a clip underneath via the Cropping parameters. Additionally, if you 
import a project from an NLE that has keyframed sizing settings, those keyframes will be imported 
and exposed within Resolve.

The primary controls for keyframing are within the Inspector. Any parameter that can be keyframed 
has a gray keyframe button to the right of its slider. If the playhead is on a keyframe, this button 
turns orange and small navigation arrows appear to its right and left, otherwise it stays gray.

Orange Keyframe buttons in the Inspector show there’s a keyframe at that frame

Once you’ve keyframed one or more parameters within a particular group in the Inspector, that clip 
displays a small button at the far right of its name bar in the Timeline. Only keyframed clips have 
this button.

The Keyframe track button in the Timeline appearing on a keyframed clip

Clicking this button exposes the keyframe tracks for that clip. Each group of parameters in the 
Inspector has a single keyframe track, that holds all the keyframes of all the parameters within that 
group. For example, the Pan, Tilt, Zoom, Rotation Angle, and Anchor Point keyframes all appear 
within the Transform track.

Keyframing Effects in the Edit Page
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Additionally, each keyframe track has a Curve button that, when clicked, exposes that parameter 
within a Curve Editor that’s attached to the clip in the Timeline.

A clip’s curve editor showing the Opacity curve

Multiple parameters can be opened within the Curve Editor at the same time, and you can choose 
which curve to work on by clicking it in the Curve Editor, or clicking one of that parameter’s keyframes 
in the keyframe track above. Selected control points can be moved, and their bezier interpolation 
changed using one of the four buttons located at the top of the Curve Editor.

Keyframing in the Inspector

Keyframing in the Edit page works slightly differently than when using the keyframe editor in the 
Color page. Most simple keyframing tasks can be performed in the Inspector using three buttons 
that appear to the right of any parameter that’s capable of being keyframed.

The three keyframe controls that appear in the Inspector, from left to right:  

Previous keyframe, Create/Delete keyframe, Next keyframe

A keyframe track for all of the Transform group parameters
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Methods of keyframing parameters in the Inspector of the Edit page:

>> To add a keyframe: Select a clip, open the Inspector, then move the Timeline playhead 
to the frame where you want to place a keyframe, and click the Keyframe button next 
to the parameter of the Inspector you want to animate. Once you’ve added at least one 
keyframe to a parameter, all other adjustments you make to parameters in the Inspector, 
or using the on-screen Transform/Crop controls in the Timeline Viewer add new keyframes 
automatically if the playhead is at another frame.

>> To move the playhead to the next or previous keyframe: Right-Bracket ( [ ) and Left-Bracket 
( ] ). You can also click the small left- or right-hand arrow to either side of a parameter’s 
keyframe control to jump the playhead to the next or previous keyframe.

>> To edit an existing keyframe of a parameter: Move the playhead to be on top of the 
keyframe you want to edit, and then change that parameter, either in the Inspector, or 
using the on-screen controls of the Timeline Viewer.

>> To delete a single keyframe: Open the Inspector, move the Timeline playhead to a frame 
with a keyframe, and click the orange Keyframe button in the Inspector to delete it.

>> To delete all keyframes for one parameter: Click the reset button to the right of a parameter’s 
keyframe control in the Inspector.

>> To delete all keyframes in a group of parameters in the Inspector: Click the reset button to 
the right of a parameter group’s title bar in the Inspector.

>> To disable or enable a single parameter’s keyframed effect: Click the orange dot at the left 
of a parameter’s keyframe track in the Timeline. Orange means that track’s enabled. Gray 
is disabled.

>> To disable or enable a group of parameters in the Inspector: Click the orange dot at the 
left of a parameter group’s title bar in the Inspector. Orange means that group is enabled. 
Gray is disabled.

Keyframing in the Timeline and Curve Editor

If you need to do more complicated keyframing than the relatively simple controls of the Inspector 
allow, you can use the Keyframe tracks and Curve Editor found in the Timeline.

The Keyframe Editor

When one or more clip parameters are keyframed, a small button appears at the far right of a clip’s 
name bar in the Timeline. Clicking this button opens the Keyframe editor, exposing one keyframe 
track for each group of parameters that’s keyframed. For example, Pan, Tilt, Zoom, and Rotation 
Angle keyframes all appear within a single keyframe track labeled Transform.
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These Keyframe tracks can be opened so you can drag keyframes left or right to control their 
timing. While you drag a keyframe, a tooltip appears showing you that keyframe’s offset in frames 
from the beginning of that clip’s source media, and the name of the parameter you’re modifying. 
You also have the option of disabling or re-enabling an entire track of keyframes by clicking the 
orange button at the far left of each Keyframe track. Click the small button at the bottom right of 
the clip’s name bar to close the Keyframe tracks when you’re finished.

The Curve Editor

If you want to work with keyframes in more detail, you can click the small Curve Editor button at the 
right of any Keyframe track, which opens the Curve Editor below.

The Curve Editor open in the Timeline

(Left) Button for opening Keyframe tracks, (Right) Keyframe tracks open in the Timeline
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You can open multiple parameters into the Curve Editor by clicking each Keyframe track’s Curve 
Editor button. When a group of parameters, such as Transform, is opened in the Curve Editor, a 
pop-up to the right of the Keyframe track’s Curve button lets you choose which parameters are 
exposed via checkboxes.

Choosing which parameters to display in the Curve Editor

While you can only work on one curve at a time, you can choose which curve is selected to edit. 
Using the control points exposed by each curve, you can edit parameters, alter keyframe timing, and 
change each control point’s interpolation to create custom easing effects affecting the acceleration 
of change from one keyframe to the next.

Methods of keyframing parameters in the Inspector of the Edit page:

>> To switch which curve you’re editing: Click the curve you want to edit in the Curve Editor so 
its name appears at the left of the Curve Editor’s title bar.

>> To drag a control point on a curve: Click any control point and drag left or right to retime 
it, and up or down to change the value of the control point. Once you begin to move the 
pointer, the control point is constrained in that direction.

>> To add a new control point to a curve: Option-click anywhere on a curve to add a new 
control point.

>> To delete a control point from a curve: Right-click a keyframe and choose Delete form the 
contextual menu.
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>> To change the interpolation of a control point: Click the control point you want to edit, and 
then click one of the four bezier interpolation buttons in the Curve Editor title bar.

>> To adjust a bezier handle: Drag the bezier handle in any direction to alter the curve.

The Curve Editor with bezier interpolated keyframes

When you’re finished working with the Curve Editor, do one of the following:

>> Click the Curve Editor button at the right of any Keyframe track to close that parameter or 
group’s curve.

>> Click the small button at the bottom right of the clip’s name bar to close the Keyframe 
tracks and the Curve Editor all at once.
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Paste Attributes

You can copy and paste attributes from one clip to multiple clips using the Paste Attributes 
command. This is a fast way to apply effects from one clip to many others in the Timeline.

To copy attributes:

1. 	 Select a clip with attributes you want to apply to other clips, and press Command-C.

2. 	 Select one or more other clips to paste to.

3. 	 Choose Edit > Paste Attributes (Option-V). 

4. 	 When the Paste Attributes window appears, click the checkboxes of each of the attributes you 
want to paste, and click Apply when you’re done.

The Paste Attributes window shows you the clip you’re copying from and the clip(s) you’re pasting 
to at the top, and provides checkboxes you can use to select which attributes you’d like to paste. 
A pop-up menu below lets you choose how you’d like to apply any keyframes that are part of the 
attributes being pasted; the options are Maintain Timing or Stretch-to-Fit.

The Paste Attributes window


